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GPS Robot License Agreement 
All contents of this manual are neither an endorsement, nor a solicitation of any 
sort, and cannot be considered as a promotional offer. All information you receive is 
unsolicited, private encoded communications of privileged, proprietary, and 
confidential information for you only and by purchasing the given product you agree 
to keep this information private, confidential, and protected from any disclosure. 
You also agree to indemnify and hold harmless the authors of this product, their 
employees, contractors, and service providers. Should any of the practices described 
herein turn out to be unlawful in any jurisdiction, individuals pursuant to its 
legislation should restrain from any intentions or attempts to apply them in any 
manner, either personally or in partnership with other individuals or entities. 
Unauthorized copying and distribution of all or any parts of this manual or product 
are strictly prohibited and will result in civil liability and criminal charges brought 
against the violators and their aides.  

 

U.S. Government Required Disclaimer - Commodity Futures Trading Commission. 
Futures and Options trading has large potential rewards, but also large potential risk. 
You must be aware of the risks and be willing to accept them in order to invest in the 
futures and options markets. Don't trade with money you can't afford to lose. This is 
neither a solicitation nor an offer to Buy/Sell futures or options. No representation is 
being made that any account will or is likely to achieve profits or losses similar to 
those discussed on this web site. The past performance of any trading system or 
methodology is not necessarily indicative of future results. 

 

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE 
CERTAIN LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED 
RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT 
BEEN EXECUTED, THE RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE 
IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. 
SIMULATED TRADING PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT 
THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION 
IS BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT OR 
LOSSES SIMILAR TO THOSE SHOWN. 
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1. Introduction 
Thank you for joining the GPS Robot team. This manual will help you install, 

activate, and use your robot for maximum profit and with minimal frustrations. 

With the purchase of your GPS Forex Robot expert advisor, you gained access 
to our member’s area, along with this manual and all required robot files available 
for download there. It is important that you download all required robot files to your 
computer and save them in a handy place to be able to use them during the 
installation process. The GPS Forex Robot can be installed in two different ways. To 
facilitate finding the necessary files for both methods you can check with this list:  

For the First method:  

 GPSForexRobotSetup.exe  

For the Second method:  

 GPSForexRobotEURUSD.ex4  

 GPSForexRobotEURUSD.dll 

 GPSForexRobotUSDCHF.ex4  

 GPSForexRobotUSDCHF.dll 

 GPSForexRobotEURGBP.ex4  

 GPSForexRobotEURGBP.dll 

You can choose only one method, which suits you better. It is also essential 
that you have these files to proceed with setting up your GPS Forex Robot expert 
advisor. We recommend saving them to your desktop for your convenience and to 
start working. 
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2. Getting started 
The first thing you need to do after downloading the robot files is deciding 

which broker you are going to trade with. For this purpose, we highly recommend 
IamFX, which is a fair STP broker with market execution. In this manual, we will 
describe the installation on the example of IamFX. However, should you choose a 
different broker, don’t worry, the GPS Forex Robot works fine with other brokers as 
well, and the installation is rather similar.  

Prior to running your robot on a live account, we recommend you to get 
acquainted with it on a demo account first. The subsequent pages of this manual 
describe how to register a demo account.  

To open a DEMO account with IamFX, please, go to 
https://www.iamfx.com/freedemo.php. Enter your full name, e-mail address, choose 
your country and then click the “Submit” button, as shown below. 

 

  

http://www.iamfx.com/
http://www.iamfx.com/freedemo.php
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Next, you will be transferred to the page where you can download the IamFX 
Meta Trader 4 platform. A link to this page will also be dispatched to your email, so 
that if you have to download the platform again anytime in the future, you can 
quickly access the required page.  

As soon as the page loads on your screen, a dialogue box will appear 
prompting you to save the setup file to your computer. You can either save it to your 
computer or resume the installation later or you can run it straight away by clicking 
on “Run.” 

 

If you decide to save it to your computer, you will also have to select a 
directory to save the setup program. For your convenience, we recommend you to 
save it to your desktop. 
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After the installer file downloads to your computer, you will most likely be 
asked for a permission to run it. This is the Windows built-in security, and you should 
confirm any messages for the program to be able to install it correctly.  

You might also see warnings from your antivirus system. Since such software 
is heavily coded to prevent reverse engineering, it might be seen as a virus by some 
security systems, which are, for some reason, unable to detect the difference 
between such security measures and true malware.  

During the installation process, you should be prompted consequently to 
such windows. 

 

 

Make sure you select your preferred language and click on “Next.”



8 
 

Next, you will be prompted to select the path into which you wish to 
install your Meta Trader 4 platform. We recommend that you leave it set to 
default, which is the most convenient path option. 

 

 

 Important: Make a note of the installation folder path. You will need to 
know the location later in order to install any other robots.  

Click “Next” after you have decided on your path, and the setup program 
will place all the necessary Meta Trader 4 files into the selected directory. After 
the installation is finished, click on “Finish,” and run your Meta Trader 4.  

When Meta Trader 4 starts up for the first time, you will need to create a 
Demo (Practice) account. 
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First, make sure that you provide all of the details shown in red, and check 
the box “I Agree To Subscribe To Your Newsletters.” Then, select the desired 
“Deposit” and “Leverage” values. We recommend that you use the same leverage 
and deposit features that you wish to see on you live account.  

Currently, the maximal leverage option for IamFX is 400:1, and minimal 
deposits start with $500. You can find additional information about the IamFX 
conditions by visiting their site at http://www.iamfx.com. 

After you fill in all the required fields, click on “Next.” 

  

http://www.iamfx.com/
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The following window is designed to select a demo server for your trading. 
In most cases, there is only one option. However, feel free to select any demo 
server available and click on “Next.” 

 

After selecting your server, you will be able to access your demo account 
login details.  

We highly recommend making a note of them in order to be able to access 
your demo account later from other platforms. Do not use the “Investor” 
password while logging in. With an investor password, you will not be able to 
trade on your account, as it is a read-only access feature. Investor passwords can 
be used, for example, if you want to show your account results to a third party, 
but you will not be able to trade with it! 
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Finally, click the “Finish” button to complete the account registration 
process. Normally, you will be logged into your account right after clicking on 
“Finish.” Should you need to log in again, you can click on “File” > “Login.”  

After doing that, please ensure that you CLOSE the Meta Trader 4 window. 
All EA installations should be performed when your trading platform is closed, 
otherwise you might face a series of different problems in the installation process. 
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3. Installation of GPS Forex Robot 

In this section, we discuss how to install the GPS Forex Robot on your 
Meta Trader 4 platform. There are two methods and here we have detailed 
instructions for each method. 

3.1 First Method 
This is the recommended and most convenient method to install the GPS 

Forex Robot. To install it this way you will need only one file: 

 GPSForexRobotSetup.exe  

First of all, you will need to find the GPSForexRobotSetup.exe file on your 
computer and run it by double clicking on the respective file icon:  

 

In the first window of the installation, read the small note about the setup 
wizard and go to the next step by clicking “Next.” 
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The second window of the installation will prompt you to agree to the 
Software License Agreement. Read and confirm it by clicking on “I Agree.” 

 
 

At the next stage, you should choose the Meta Trader 4 folder in which 
you want to install the GPS Forex Robot by clicking “Browse.” 
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In our case, it’s IamFX MT4. Please keep in mind that it is crucial to select 
only the root folder of your Meta Trader 4 – not the experts or libraries folders. 
Then go to the next step by clicking “OK.” 

  
 

After you choose your Meta Trader 4 folder, make sure it is highlighted 
and displayed in the field as well and then go to the next step by clicking “Next.” 
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In the next window, check the destination folder and click on “Install.” 

  
 

Finally, you will see the “GPS Forex Robot Has Been Installed On Your 
Computer” window. Please review ReadMe (User Guide) before continuing by 
clicking “Finish”. 
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3.2 Second Method 

Important: Use the second method of the GPS Forex Robot installation 
only if the first method doesn’t work. Though it is a classic method of robot 
installation, it is more complicated and is used only in cases where the automated 
setup doesn’t work. 

To use this method, you should find the following six files on your computer: 

 GPSForexRobotEURUSD.ex4  

 GPSForexRobotEURUSD.dll 

 GPSForexRobotUSDCHF.ex4  

 GPSForexRobotUSDCHF.dll 

 GPSForexRobotEURGBP.ex4  

 GPSForexRobotEURGBP.dll 

 

 Do not open any of these files – they are not executable and should be 
pasted according to the following instructions: 

 

First of all, you need to copy the next files into the necessary folder: 

 GPSForexRobotEURUSD.ex4 

 GPSForexRobotUSDCHF.ex4 

 GPSForexRobotEURGBP.ex4 
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You can begin by clicking on the file icon and selecting “Copy” in the drop-down 
menu that will pop up. 

 

 

Next, you will have to remember the folder where your Meta Trader 4 is 
installed. For IamFX with the default installation options, you can find it at 
C:/Program Files/IamFX MT4/. This path varies with different brokers, so we 
highly recommend noting down the path during the respective stage of your Meta 
Trader 4 installation process.  

Furthermore, in some cases, and in particular if you are running a 64-bit 
Windows version, the Program Files folder might look like “Program Files(x86)” or 
“Program Files(x32).” 

If you experience any problems locating your platform, you can move your 
mouse cursor over the Meta Trader 4 icon for a few seconds, and a pop-up will 
show you the correct path. 
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Now that you have found the necessary path to your Meta Trader 4 folder, 
you can open “My Computer” or “Computer” for Windows 7 or Vista. That should 
open the built-in Windows Explorer application, which allows you to browse your 
computer files system. 

On this example, you can see how we proceed to the “Experts” folder by 
double-clicking on all subsequent folders specified in the path we determined 
earlier - Local Drive C:/Program Files. 

 

The IamFX MT4 folder:  

 

 

 



19 
 

The “Experts” folder:  

 
 

After you get to the Meta Trader 4 folder, it is very important that you 
open the “Experts” folder. Here, you can paste the file by clicking on any empty 
space and selecting “Paste” from the dropdown menu. 
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After you paste the next files into the “Experts” folder: 

 GPSForexRobotEURUSD.ex4 

 GPSForexRobotUSDCHF.ex4, 

 GPSForexRobotEURGBP.ex4, 

In the same folder locate the “Libraries” folder. Proceed into that folder, 
and repeat the previous instructions with the next files: 

 GPSForexRobotEURUSD.dll  

 GPSForexRobotUSDCHF.dll 

 GPSForexRobotEURGBP.dll 

Like on the picture below: 
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4. Meta Trader 4 Settings 

Once you have finished installing the GPS Forex Robot files, the next thing 
to do is to launch your IamFX MT4 platform by double-clicking on the IamFX MT4 
icon. 

 

 

 Proceed to Tools –> Options menu.  

 

 

This step is critically important for any Expert Advisors to work on 
backtests, as well as for saving you from having trouble setting up your EA every 
time you run it. 
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All you have to do here is click on the Expert Advisors tab and ensure that 
the boxes are checked exactly as shown below. 

 

 

Do not overlook the “Confirm DLL Function Calls” option, which should be 
unchecked, otherwise the robot will not be able to function properly. You may 
also wish to uncheck “Disable Experts When The Account Has Been Changed” and 
“Disable Experts When The Profile Has Been Changed” options, though this is 
more for convenience rather than a requirement. After you have checked all 
needed fields, click “OK.” 
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5. Preparing the GPS Robot to trade 

Having installed the robot, restart your Meta Trader 4 platform and check 
the Navigator panel on the left-hand side of the Meta Trader 4 window. Clicking 
the small [+] to the left of “Expert Advisors” will expand that section to display all 
installed Expert Advisors.  

 

 

Do not worry that the GPS Forex Robot icons is gray in this list, even 
though all other icons are colored. This is normal for all commercial Expert 
Advisors. A colored icon means that you have the “Source Code” for that 
particular expert. 

If you cannot find the GPS Forex Robot icons on this list, it is likely that you 
have installed the robot into an incorrect directory. In that case, we would 
recommend carefully going through the installation process again.  This often 
happens when you have several Meta Trader 4 platforms installed on your 
computer. You can check the folders and reinstall the robot into the correct folder 
or you might have simply forgotten to restart your Meta Trader 4. 
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After you install all of the 
robot files, and locate the GPS Forex 
Robot icon on the Navigator panel. 
You need to open the chart with the 
feed necessary for your robot to 
trade. For GPS Forex Robot, it is the 
EURUSD, USDCHF and EURGBP charts. 

To open a new chart, simply click on 
“File” and select “New Chart.” You will 
then be prompted to select the 
desired currency pair in the drop-
down menu that will instantly appear. 

 

 

After opening the required chart, EURUSD, USDCHF or EURGBP, you can 
select any timeframe which will be comfortable to you because it’s does not 
matter to the GPS Forex Robot what timeframe you will be using. However, we 
are recommending that you use the H1 or M15 timeframe. To do this, click on the 
chart, then on the H1, for example, button in the top part of your Meta Trader 4 
window. 

 

 

After you have the necessary chart opened and the H1 timeframe 
selected, you can start attaching the robot to the chart. 

In this manual, we will explain how to attach the GPS Forex Robot to the 
EURUSD chart only, but if you wish to use it with the USDCHF or EURGBP currency 
pairs as well, you can follow the same instructions for that chart.  
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To attach the robot, select the necessary chart and follow the subsequent 
instructions.  

On the Navigator panel, right-click on the GPSForexRobotEURUSD icon 
and select “Attach To A Chart” in the menu as it is shown below. 

 
 

When you attach the robot to the chart, the “Properties” dialog window 
will open. The dialog window contains two tabs, “Common” and “Inputs.” 

The “Common” tab looks like this. 
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It is crucial that all of the settings highlighted with the red arrow are 
matching the image above or the GPS Forex Robot will not be able to function 
properly. 

Assuming that everything else is correct, the “Inputs” tab looks like this. 

 
 

If you scroll down this inputs section, you will be able to see a number of 
adjustable settings, which are explained in the following several pages of the 
manual. If you wish to change any of the settings, just double-click in the “Value” 
field of the desired setting, and enter the new value. To apply the changes, click 
“OK.” This will restart the robot with the new settings. 

Now we are ready to start trading. Depending on how well you have 
followed our instructions so far, there will be one of three possible things 
displayed in the top-right corner of the chart to which the robot is attached. 

- A smiley face indicates that the robot is correctly installed 
and ready to trade. 

- X means that you forgot to enable the Expert Advisor 
trading in Meta Trader 4. Make sure that the big Expert 

Advisors button on the top toolbar of Meta Trader 4 is hit. 
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- A sad face indicates that you did not allow live trading. 

 

Just press F7 and make sure that the “ALLOW LIVE TRADING” checkbox is 
checked. 
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6. GPS Forex Robot Settings 

Authentication settings: 

Email – This is your e-mail address that you use when you purchased the GPS 
Forex Robot. 

CBReceipt - This is your license number and ClickBank receipt number all in one, 
and it is used by the GPS Forex Robot to ensure that you are not using a pirated 
copy of this product. You can find this code in the e-mail message from ClickBank, 
which was dispatched to you immediately after you made the purchase. It is very 
important that you have a valid Receipt Code, as without this setting the robot 
will not be able to function at all. 

 

Size of lots settings: 

UseMM - If set to True, the robot uses its built-in Money Management System, 
which will set the trading lot size according to your current deposit size. At the 
beginning, we recommend you use the Money Management by default setting - it 
is False. If it is set to False, it will automatically revert to the fixed lot size specified 
in the Lots setting. 

Lots - This is the base lot value that will be used for your current account. 

Important: Use 0.01 lot size for every $100 of your account. For example, if you 
have a deposit of $500, you should set the value of the lot size for every expert at 
0.05, if you have a deposit of $1000, the lot size value should be 0.1. 

LotsRiskReductor - This is the value of risks that will be used when the UseMM 
setting is set to True. In general, this is the percentage value of the Free Margin 
used to open the position. 

MaxLots - Maximum lot size. 
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General Options: 

AutoGMTOffset - When it set to True (default), the robot will calculate the GMT 
offset of your broker’s server automatically. This is often the safest approach as it 
can automatically adjust to Daylight Savings. Unfortunately, this is not possible 
when you’re using the Strategy Tester and a manually specified value is therefore 
required in order to achieve the correct backtest results. We highly recommend 
setting it to True. 

GMTOffset – This defines the time offset of your broker in relation to GMT. If in 
doubt, your broker will confirm their GMT offset to you upon your inquiry. This 
parameter is primarily used for Strategy Testing or in the event that the automatic 
computation of the GMT Offset is not appropriate. 

 

Other settings: 

ExpertComment - The comment that will be written when the GPS Forex Robot 
will make trading operations. 

ColorBuy – This is the color of the arrow that will be drawing on the chart when 
the GPS Forex Robot will be in the Buy mode. 

ColorSell – This is the color of the arrow that will be drawing on the chart when 
the GPS Forex Robot will be in the Sell mode. 

SendEmail - By using this setting, you can setup Meta Trader 4 to send you emails 
about the new trading operations of the GPS Forex Robot. You can configure 
these email settings in Meta Trader 4. For this, go to Tools -> Options -> Email. 
Read the Meta Trader 4 help for more information on this setting. 

SoundAlert - Play sound when the GPS Forex Robot makes a trading. 

WriteLog - Writes comments to the Log. 

WriteDebugLog - Writes comments to the Journal of Meta Trader 4. 
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7. GPS Forex Robot On-chart Messages 
If you installed the GPS Forex Robot correctly, the following on-chart 

message should automatically appear in the top left part of your chart. 

 

Authentication status: 

Authenticated - This message will display if the robot has verified the 
authentication information successfully and is functioning properly. 

 

General information: 

Broker Company - Your broker company name. 

Terminal Company - Your terminal company name. 

Server Name – This is the name of the server that is currently being used by your 
Meta Trader 4 terminal. 

Current Server Time - This displays the current time of the server that is currently 
being used by your Meta Trader 4 terminal. 
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Account information: 

Account Name - The name of your current account. 

Account Number - The number of your current account. 

Account Type - The type of your current account (Demo or Real). 

Account Leverage - The leverage of your current account. 

Account Balance - The balance of your current account. 

Account Equity - The equity of your current account. 

Account Floating P/L - The current floating P/L for all open trades of your current 
account. 

Account Currency - The currency of your current account. 

 

Additional information: 

Current Spread - The value of the spread for the current open chart of the 
currency pair, for example it is the EURUSD on the picture above. 

Maximum Spread - The maximum value of the spread. 

Free Margin - The value of the current free margin for your current account. 

Used Margin - The value of the margin currently being used for your current 
account. 

 

GMT Settings: 

GMT Offset - The current value of the GMT Offset of your broker, use this value 
for Strategy Testing. 
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8. Activation of your Real Money Account 
The GPS Forex Robot License is valid for the Activation of an unlimited 

number of Demo trading accounts, but only for one Live Real Money account.  

If you set your copy of the GPS Forex Robot on the Real Money Account, 
you will see next message on the chart: 

 

To activate your Real Money Account, you should go to the 
http://gpsforexrobot.com/memberarea/licenses/ where you will see a field with 
your ClickBank Receipt and Your Live Real Money Account. Please enter the 
number of your Real Money Account in the appropriate field and click “Change 
Live Account.” 

 

 

http://gpsforexrobot.com/memberarea/licenses/
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Next, you will see the confirmation “Account Number Has Been 
Successfully Changed!” 

 

 After that please set your copy of the GPS Forex Robot on the Real Money 
Account again, and you will see all on chart messages, where in the “Account 
Type” you will see “Real.” 

 

Now the GPS Forex Robot is ready to start trading on your Real Money 
Account! 
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9. GPS Forex Robot Strategy Test  

on Alpari UK 
In this section, we consider how do the backtests, tests on the historical 

data, of GPS Forex Robot on the Alpari UK brokerage. 

If you not have the Meta Trader 4 platform of Alpari UK Brokerage, you 
can download the setup file of it here. 

 
http://www.alpari.co.uk/en/trading_platforms/metatrader4/download.html 

If you already have the Meta Trader 4 platform of Alpari UK Brokerage, 
you should first download the historical data for backtesting. To do so, follow 
these instructions. 

1. Launch the Meta Trader 4 platform. 

2. Next go to Tools -> Options and you will see window with the settings. 

3. Choose the Charts tab. 

 

http://www.alpari.co.uk/en/trading_platforms/metatrader4/download.html
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4. In the fields “Max Bars In History” and “Max Bars In Chart,” change the 
current values to “9999999999999” and then click “OK.” 

 
 

5. Next, go to the Tools -> History Center and in the opened window find 
the “EURUSD” currency. Double click the “EURUSD M1” button and then  click the 
“Download” button below to download history data from MetaQuotes. 
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6. Do the same for the other timeframes, M15, M30 and so on, when the 
download is complete, close the “History Center” window. 

7. Now, you are ready to do the backtests and you should go to View -> 
Strategy Tester. 

 

8. From the opened window in the “Expert Advisor” menu, choose the 
“GPSForexRobotEURUSD,” in the “Symbol” menu choose the “EURUSD pair,” and 
for  the “Model” menu choose “Every Tick” setting. After that, choose “Use Date” 
and set it from 04-09-2007 (for the EURUSD pair) to today’s date and in the 
“Period” menu choose the timeframe, we recommend M15 or H1. 

 

Important: Don't do the backtests on the weekends because in this time the spread is 
not a market value. 
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9. Click the “Expert Properties” button and in the opened window, choose 
the Testing tab. Type in the “Initial Deposit” menu, for example $10,000. In the 
“Positions” menu choose “Long and Short” and check “Genetic Algorithm.” 

 
 

10. Next, choose the Inputs tab. Type your Email and CBReceipt number, 
after that you should change the lot size. As you should remember, the maximum 
value of the lot size is 0.01 for every $100 of your deposit. In the last step we 
chose the $10,000 deposit, so we should type the lot size is 1, because:  
$10,000/$100 * 0.01 = 1. 
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Then you should to set the “AutoGMTOffset” to False, and type the value of 
brokers gmt offset in the “GMTOffset” menu, for Alpari UK, it is 1 (you can find 
this value on the chart in the GMT SETTINGS menu) and finally click “OK.” 

 

 

11. Now it’s time to do the backtests, for it you should just click “Start” 
button. 

 

 

12. Finally, you will see the results of the backtest. 
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10. Troubleshooting 
The expert advisor is not working 

First of all, please make sure that all installation steps from the manual 
were performed correctly. If you did not locate any errors in the installation 
process, have a look under the “Experts” and “Journal” tabs in the “Terminal” 
window of your Meta Trader 4 to identify your problem.  

 

DLL calls are not allowed  

Please, make sure that under the Tools->Options->Expert advisors tab of 
your Meta Trader 4 platform, the “Allow DLL Imports” box is checked. If not, 
check it, confirm the changes, and reattach your robot to the chart. Also, make 
sure that “Allow Live Trading” is checked and “Confirm DLL Function Calls” is 
unchecked, as these settings are also crucial for your robot’s trading.  

 

Authentication Failed: [Wrong E-Mail or CBReceipt] 

Please, make sure that you have entered your e-mail address and 
purchase receipt number correctly – if not, click the smiley face icon or press F7 to 
open the “Inputs” tab and enter the code again. 

 

Other problems 

If you are experiencing any issues that are not covered in the user’s 
manual, please send your message to the support team at 
support@gpsforexrobot.com, providing as much detail as possible. Any 
screenshots or additional information will be appreciated. 
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11. How to stop trading 
There are several ways to stop the robot’s trading. 

 

1) In case you use several robots on your account and want to completely 
stop the trading of all EAs, click the green “Expert Advisors” button in the toolbar. 
Please, be aware that this will also stop any other Expert Advisors that you may 
be running on your account. 

  

 

2) If you want to remove only one robot, you can do so by clicking on the 
Smiley Face and choosing “REMOVE” in the Expert Advisors menu. 

 

 

3) If you don’t want to remove the EA, you can simply disable its live 
trading ability by pressing F7 and un-checking the “Allow Live Trading” checkbox. 

 


